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If you are not satisfied with any Gopher purchase for any  
reason at any time, contact us and we will replace the  
product, credit your account, or refund the purchase price.

Read instructions in their entirety. In the event of missing parts, call 1-800-533-0446.

Thank you for purchasing this product from Gopher.

*This FITstep™ software can be used with both FITstep™ Stream™ pedometers, as well as FITstep™ Pro pedometers and data from 
previous software will convert.

Operating System Requirements

Operating System Windows® 8, Windows® 10, and Windows® 11

Free Hard Drive Space At least 50mb

Installing the Software

To download the FITstep™ software, go to www.gophersport.com/info/software. Click on the Windows Version 4 User Software 
Download, follow the prompts to install. The file will first check to see if your PC is ready for a successful installation. Install the 
software and restart your computer. Click on the FITstepSetup_X.X.X.msi (version number will change) file again and it will install. 
A Gopher FITstep™ Version 4 icon will be placed on your desktop for easy startup. As part of the installation process, any data you 
collected with the previous version of the software is converted to work with the new version. It is not necessary to re-enter student 
names, pedometer numbers, or classes. Also, it is important to note that the installation process will create a backup file that you can 
use with your older version of the FITstep™ software. 

Using the Software Menu

Firmware Update Pop-Up

Due to frequent updates in technology, the FITstep™ Stream™ pedometers may need to be updated prior to use, or at any time. The 
pop-up pictured below appears when the software opens. Directions to update the firmware in the pedometers is found on page 4 of 
the instructions. 

This pop-up can be disabled by unchecking the “Show on Startup” box. 

Microsoft® Windows® Software 
Manual for FITstep™ Stream™ Version 5
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*If you chose to disable this pop-up, it is recommended to check the pedometers for firmware updates periodically. Not updating 
pedometers may result in pedometers not functioning properly.

Proceed with initial software setup by exiting out of the pop-up. 

Main Software Page

The screen pictured below appears when the software opens. The components in the menu bar are used for file operations, printing, 
and importing/exporting data. 

The screen is divided into two major parts. The left window is hierarchical and breaks down by instructor to grades to classes to 
students. To make the next level appear, double click on the top level tile or click on the triangle to the left of the name. The right 
window is the main viewing window; class/student information is entered here, full class lists are shown, and uploaded data can be 
viewed. To use any of the tabs on the right side of the screen, a class must be selected. 

It is possible to utilize the Reports Tab function with more than one instructor, student, class, and/or grade by holding the control key 
down and clicking the names of the desired items. A range of items can be selected by holding the shift key down, clicking the first 
item in the range, and clicking the last item in the range. 

FILE MENU

Database

The database houses all information from the FITstep™ software. It is recommended to store the database on the computer desktop 
for easy access. 

All FITstep™ databases are stored as *.db files. The asterisk (*) signifies the name of your file.

Opening an Existing Database
If you used previous versions of the software, your database file will convert to work with the new software. If you use multiple 
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databases or want to open one you converted from the old software, use the following steps:

1.	 File

2.	 Open Database

3.	 A Finder window will open and allow you to search for your desired database. Select the database and click Open. 

New Database

If you have not previously stored pedometer data using an earlier version of the software, complete the steps below to create a new 
file to store data. If this is the first time you have used the software or if it cannot find your database, it will create a new one with the 
name pedometerData.db.

NOTE: if working with other teachers using the same computer, each should create a personal database. This will allow each user 
to open his/her database when he/she is ready to collect data or print reports. It is possible for multiple teachers to share the same 
database, but it gives all teachers access to others’ data. An advantage of one database is that students can be moved easily from one 
teacher to another. 

Follow these steps to create a new database:

1.	 File

2.	 New Database

3.	 Select the location to store the database (desktop is recommended).

4.	 The software will automatically name the database pedometerData.db, but this can be renamed as desired.

5.	 Select Save. 

Once Database is located or created, proceed to HUB™ Setup instructions. 

HUB™ Setup
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The Gopher HUB™ allows for data transfer from the FITStep™ Stream™ pedometer to the FITstep™ software using ANT+™ radio 
technology. 

1.	 To set up the HUB™, plug the HUB™ into the computer using the provided USB cord. 

2.	 The computer will connect to the HUB™.

3.	 The FITstep™ software will register the HUB™ as indicated in the lower left hand corner (if also using FITstep™ Pro 
pedometers and Readers, the software will register the Reader in the left hand corner as well). 

NOTE: Due to frequent updates in technology, the firmware within the HUB™ may request to be updated. A pop-up will prompt you to 
start the update process. Press the start button and wait for the update to complete. This could take up to 90 seconds. The software 
will indicate the connection to the HUB™ in the lower left hand corner when the software is ready to proceed with use. 
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TABS

Pedometer Setup

The Pedometer Setup Tab has two purposes: to update the pedometer firmware and to embed a number in the pedometer. Embed 
pedometer numbers before using them with students and update pedometer firmware when required. Here is a suggested procedure 
for both actions:

Firmware Update

1.	 Pedometer may be in a deep sleep mode to conserve battery life. To wake the pedometer, press and hold the reset button 
until the screen comes on.

NOTE: for best results wake all pedometers from deep sleep mode before continuing with updates.

2.	 Click the Pedometer Setup Tab to see the screen below. 

3.	 Select the first pedometer you wish to update, press the blue button on the front outside cover of the pedometer and place it 
directly on top of the HUB™. 

4.	 A box will pop up prompting you to begin the firmware update. Press start. 

5.	 The software will show the progress of the update and indicate when it is finished. 

6.	 Once the update has finished, click done and remove the pedometer and continue to the next pedometer you wish to update 
and repeat the process. 

7.	 The firmware update to the pedometers can only be done using only the Pedometer Setup Tab.

8.	 The pedometer update should take about 17 seconds. In the rare occurrence that the update fails, the pedometer will retry the 
update which will take an additional 10 seconds.

NOTE: it is rare for a pedometer update to fail, but if an update fail occurs, set the pedometer aside and continue updating remaining 
pedometers. Return to the failed pedometer after 2 minutes and try the update process again. This should result in a successful update.
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Pedometer Numbering

1.	 Number the pedometers on the outside and inside of the pedometer covers. This will make it easy for students to identify 
pedometers each time they come to class. It may be easiest to start with pedometer 1 and number from that point forward. 
However, numbering can be started at any integer. 

2.	 Pedometer may be in a deep sleep mode to conserve battery life. To wake the pedometer, press and hold the reset button 
until the screen comes on. 

3.	 Click the Pedometer Setup Tab to see the screen below. Click on the “Write New Number” box. Set the new pedometer 
number to the desired starting number. For example, if you set the new number to 1, that pedometer will be internally 
assigned the number 1. 



Page 7 of 13
01/19/24
© 2018 Gopher 1-800-533-0446  •  www.GopherSport.com

4.	 Select the first pedometer you wish to number, press the blue button on the front outside cover of the pedometer, and place it 
directly on top of the HUB™. 

5.	 The software will register the pedometer and assign it to the number identified. Press OK to move on to numbering the next 
pedometer. 

6.	 The software will automatically change to the next integer. You are now ready to press the blue button on the next pedometer 
and place it on top of the HUB. 

7.	 To check whether the correct number has been assigned to the pedometer, press the Mode button on the pedometer until 
the Step screen is showing. Now hold down the Set button to see the pedometer number. It will appear as P=00001 if you 
embedded number 1. 

NOTE: nothing will show on this screen if the pedometer has not been numbered. 

8.	 To manually change a pedometer number, check the “Write New Number” box and type in a new number. Press the blue 
button on the front of the pedometer, place it directly on top of the HUB™, and the new number will be assigned. A pedometer 
number can only be changed using the Pedometer Setup Tab. 

NOTE: Both firmware updates and pedometer numbering can be done simultaneously by checking the “Write New Number” box 
assigning the pedometer number, pressing the blue button on the front of the pedometer and placing it on top of the HUB. The 
software will first prompt you to update the firmware and will then assign the number once the update is complete. It should be noted 
that this process will take longer per pedometer than updating the firmware and then assigning numbers. 

Class Setup

The Class Setup Tab is the control center where you will add new instructors, grades, classes, and students. Not all fields will need 
to be filled, such as the instructor number and description fields. Notice how the data is organized. The top field is the instructor, 
usually the Physical Education teacher. Next is Grade followed by the Class Name, which might be listed as a classroom teacher 
in an elementary school or as a number class in secondary schools (for example, 3rd Period). If desired, type in a description of the 
class with information that might be relevant. Finally, in the last section add the students by first and last name, gender (optional), and 
pedometer number. If desired, a student ID number can also be added. 
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Manual Entry Class Setup

Teachers, students, and classes can be entered into the FITstep™ software manually by typing the information into each specific field. 

Import Students into Class

The Import/Export Menu offers the opportunity to import students into the FITstep™ Software using a spreadsheet. 

NOTE: Data can only be uploaded from an Excel 2007 or higher (.xlsx) workbook. Multiple classes can be stored in the same 
workbook, but each class must be in a separate worksheet. The worksheets do not need to be named, however naming them makes 
it easier to identify different classes that exist in the same spreadsheet. 

The workbook should be set up in columns as follows: First Name, Last Name, Gender, Pedometer Number, and Student Number 
(See example below). 

NOTES:

	• Data cannot be imported unless a first and last name is provided. 

	• Pedometer numbers must be integers greater than zero. 

	• The software will accept gender identifiers of “Male”, “M”, “Boy”, or “B” for males. 

	• The software will accept gender identifiers of “Female”, “F”, “Girl”, or “G” for females. 

	• The student number field is available for adding student IDs or other unique identifier. This field accepts characters and 
numbers. 

	• Columns do not need to be in a particular order. 

Export Full Database to Excel

The Import/Export Menu allows you to place all data into an Excel workbook. The created workbook will contain five worksheets for 
instructors, grades, classes, students, and workouts. This command should not be used for backing up data since once it is exported 
to Excel, it cannot be imported back into the FITstep® software. The primary purpose for this command is to do further statistical 
analysis in Excel. 
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Upload Pedometer Data

The software works with the Gopher HUB™. The HUB™ quickly uploads the data per student using radio frequencies. The HUB™ must 
be plugged into a USB port on your computer. The software will indicate the HUB™ is connected to your computer in the bottom left 
of the screen. 

To upload pedometer data, follow the steps below:

1.	 Select the class on the left hand side of the screen. 

NOTE: Data cannot be transferred from class to class. 

2.	 Select the Upload Pedometer Data Tab. 

3.	 Ensure students position themselves approximately 10' away from the HUB™ with a clear line of sight to the HUB™. 

NOTE: Since all environments are different, data may transfer at a greater distance than 10'.

4.	 Students press the blue button on the front of the pedometer. 

NOTE: For best results, have students open the pedometer, press the blue button on the front, and watch for the up arrow to 
ensure upload has begun. 

5.	 As data is uploaded, the students’ names in the left window will change color and re-sort as shown in the screenshot below. 
The color of a student’s name offers the user the following information:

Black Font: Students have not pressed the upload button or the pedometer is not in use.

Green Font: Data was successfully uploaded. 

Red Font: Data upload was unsuccessful. This may occur if the radio signal from the pedometer was interrupted. It is 
important to note that the radio signal will not transmit through bodies, so students should not be standing behind one another. 

Blue Font: Uploading process is in progress. 

6.	 To have pedometers clear automatically after data upload, select the "Auto Clear Pedometer Data" button in the preferences 
menu at the top of the screen. 

	 NOTE: Pedometers can be removed from waist and held aloft for best radio signal. 
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Recommended for Upload

Be sure to check the total number of workouts recorded at the bottom of the screen. This number should match the number of 
students present during the session. A pop-up box will appear when switching from class to class showing any unsuccessful data 
uploads. 

Any student that is present and his/her name remains black or turns red due to an erroneous read, simply needs to press the blue 
button on the front of the pedometer again to successfully upload data. 

REPORTS

The Reports Tab is the data analysis center. Click on the Reports Tab to see different types of reports. All reports can be sorted 
and then printed, and different columns can be selected by checking the boxes on the right side of the screen. The columns can be 
reordered by dragging a column to the desired location. 

Sorting: The default order of sort is by name in ascending order. To sort any column in descending order, click on the title of the 
column you want to sort and order will be reversed. Click it again and it will return to ascending order. Sorting will move entire rows, 
not just the column you clicked on. 

Date Range: You may choose the date range for all reports. Click on the Date Range indicators in the top right corner of the Reports 
Tab. The date may be entered manually or selected using the calendar button. Select your desired date range, i.e. if you only wish to 
view May 1 to June 1, select those start and end dates. 

NOTE: It is not possible to select dates for the Class Roster report. 

Columns: Select the columns you wish to show in your reports. 

Filtering Data: Data filtering is used to view a subset of a large amount of data. You can filter data by clicking on the filter icon (the 
funnel) in the column header. This brings up a filter window. In this window, you can check one of the values for the column or select 
the rows that are equal to, not equal to, less than, less than or equal to, greater than, or greater than or equal to a value that you enter 
into the input box. After filtering a column, simply click the “Clear Filter” button to remove the filter. 

NOTE: When a column filter is active, the funnel icon changes color. If data appears to be missing, check to ensure the filter has been 
cleared. 



Page 11 of 13
01/19/24

© 2018 Gopher 1-800-533-0446  •  www.GopherSport.com

Brief Description of Reports

Students may upload their data multiple times during the day. To preview reports before printing, click on the File Menu and select 
Print. 

1.	 The Workouts Report shows all uploads for each student. Every time a student uploads data, it is stored as a workout. If there 
are multiple workouts uploaded in one day, each workout will be recorded separately. The average will reflect this total number 
of workouts.

2.	 The Quick Summary Report offers a summative view for each class or classes. This is an excellent report for comparing 
students, classes, grades, and instructors. 

3.	 The Weekly Summary Report shows each student and his/her workouts by week. This allows you to analyze students and your 
lessons on a week-by-week basis. 

4.	 The Monthly Summary Reports show each student and his/her monthly totals and averages. 

5.	 Class Roster offers you the opportunity to print out a list of your students by class. You can print a number of classes per print 
job by control-clicking on selected classes. 

6.	 Physical Activity Report allow you to print out a “My Physical Activity Report” for each student. In this report, if there are 
multiple workouts uploaded in one day the program will add together all workouts accumulated for that day. The average 
will reflect this total number of days. The report contains a message to parents and students along with the selected activity 
sheet (see below). Customize Activity Report command allows for customization of the physical activity report to suit your 
preferences. The options that can be changed are:

a.	 Edit Report Title

b.	 Edit Intro Paragraph

c.	 Change the School Logo

d.	 Add Logo to Report

There is also a preview selection for a quick look at changes made to the report. 
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Print Reports
The print function is listed under the File Menu. It is available when students have been selected and the data is listed on the screen. 

Click on the print command to see a preview of your report. If you are satisfied with the report, click on the print icon to print the 
report. If not, cancel the report and filter the data as preferred. 

Another feature of the Report Viewer is that the report may be saved in many different formats, including a PDF or Word Document. 
To do so, click on the triangle to the right of the disc (see arrow) on the command bar of the report and pull down to your desired 
formatting. 

Export Report to Excel

A report may be exported to Excel by selecting this option under the File Menu. This allows any report chosen to be exported into an 
Excel spreadsheet. The spreadsheet will be stored in the same folder where the data file is stored. If the file hasn’t been moved since 
startup, it will be stored in the folder C:\ProgramData\Gopher\FITstep\.

General Report Help

All reports generally function in a similar fashion. You pick the students to report on from the class tree on the left side of the main 
window. You can also select the instructor, grade, class, or student level. Remember that the Control Key can be used to select a 
number of distinct items in the tree or the Shift Key to select ranges of data. Next, select a date range for the report. The report can be 
customized by selecting options that are available on the right hand side of the main window. Finally, click on the column name to sort 
the data. The first click will sort the data in ascending order, the second click will sort in descending order and the next click will return 
the data to its original order. 

After selecting the students/classes/grades/instructors and report features, print the report by selecting “Print Report” from the File 
Menu. This generates a separate report viewer window. From this window it is possible to print the report to a printer, view formatted 
pages on screen, or export the report to one of several file formats. To print, simply click on the printer icon and follow the steps in 
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the printer setup menu. Use the navigation arrows to scroll through the report. The file can also be saved to any of the following file 
formats: Acrobat (PDF) File, CSV (comma delimited), Excel Worksheet, PowerPoint Presentation, Rich Text Format (RTF), TIFF File, 
Web Archive, Word Document, or XPS Document. 

It is possible to “Print from Excel” from the File Menu. This creates an Excel 2007 format worksheet that has the data items selected 
for the report. The Excel File created is a data dump of items that you have selected in the order you have chosen. 

Preferences Menu

The Options Menu allows the user to set some defaults for the software. 

Select Start Date. This option is used for selecting a starting date for creating reports and screen analysis of data. This command 
dictates what the starting date will be when the software is launched. It will always start at one of the options listed below until the 
setting is changed. The following date range options may be selected:

Today – Defaults to today.

Yesterday – Defaults to yesterday. 

Current Week – Defaults to Sunday of the current week. 

Current Month – Defaults to the first day of the current month. 

Current Year – Defaults to January 1 of the current year. 

Last Week – Defaults to Sunday of the previous week. 

Last Month – Defaults to the first day of the previous month. 

Fixed Start Date – Defaults to a fixed date that is selected. This date will not change until you adjust it. You can use this feature to 
set the default date to the start of the current term, if desired. 

Custom Start Date – Allows data to be viewed from a certain number of days, weeks, months, or years. Select the time period 
(days, weeks, months, years) to go back and then select number of time periods you wish to go back. When using this option, you 
will not necessarily go back to the start of a week, month, or year. When going back by weeks, it will default to the same day of 
the week as today. When going back by months, it will default to the same day of the month as today. Finally, when going back 
years, it will default to the same day of the current month in the previous year. 

After choosing an option, click OK to verify the selection or click Cancel to abort any changes. The next time the Reports Tab is 
selected, the start date for the reports will default to the option selected. 

Show Advanced Data Options. This option can be used to check the amount of time students spend in each of the steps per minute 
levels. The FITstep™ Stream™ pedometers show how much time was spent at each SPM levels (80 to 160 steps per minute). By 
selecting the advanced data option, this data can be reviewed. 

NOTE: This feature only works when viewing the Workouts Tab in Reports. 

Help Menu

The Help Menu provides easy access to the FITstep™ Software instructions for referencing during use. Additional information can be 
found by following the Gopher Sport Web Links. 

Future updates to the FITstep™ Software will be available for download at www.gophersport.com/info/software.


